
Capitolo 27: Esecuzione dell'analisi what-if del foglio 
di calcolo 

1. Analisi di uno scenario 'What-If' in Microsoft Excel 
L'analisi di simulazione (What-If Analysis) in Excel permette di esplorare diversi scenari modificando i valori in 
celle per osservare come queste variazioni influenzano i risultati. Excel offre tre principali strumenti per 
l'analisi What-If: 
- Gestione scenari (Scenario Manager) 
- Ricerca obiettivo (Goal Seek) 
- Tabella dati (Data Table) 

a. Accesso agli strumenti di Analisi What-If 
È possibile accedere agli strumenti di Analisi What-If in diversi modi: 
 
1. **Barra multifunzione (Ribbon)**: 
   - Scheda 'Dati' (Data) → gruppo 'Previsioni' (Forecast) → 'Analisi di simulazione' (What-If Analysis). 
   - Da qui si possono selezionare: 'Gestione scenari', 'Ricerca obiettivo', 'Tabella dati'. 
 
2. **Tasti di scelta rapida (Shortcut da tastiera)**: 
   - Non esistono shortcut diretti predefiniti per queste funzionalità, ma si possono usare sequenze ALT: 
     - ALT + D + T per accedere a 'Gestione scenari' 
     - ALT + A + W + G per 'Ricerca obiettivo' 
     - ALT + A + W + T per 'Tabella dati' 
 
3. **Maschere e pulsanti**: 
   - Le interfacce delle tre funzionalità appaiono in finestra modale non appena selezionate dal menu Ribbon. 

b. Descrizione sintetica delle funzionalità 
**Gestione scenari (Scenario Manager):** consente di salvare e confrontare diversi gruppi di valori di input e 
vedere come influenzano il risultato. 
**Ricerca obiettivo (Goal Seek):** permette di determinare il valore di input necessario per ottenere un 
determinato risultato da una formula. 
**Tabella dati (Data Table):** consente di vedere l'effetto di una o due variabili su una formula, generando 
automaticamente un set di risultati. 

Esempi pratici 
Scenario: confronto tra proiezioni di profitto 
Crea uno scenario per ogni possibilità di vendita annuale e confronta i profitti risultanti. 
Goal Seek: calcolo del valore necessario 
Trova il prezzo minimo da impostare per raggiungere un utile di €10.000 partendo da una formula di utile. 
Tabella dati: variazione su due variabili 
Mostra l’effetto della variazione di prezzo e quantità sulle entrate totali. 
Scenario: budget familiare 
Prepara vari scenari con diverse spese mensili per visualizzare l’effetto sul risparmio mensile. 
Goal Seek: calcolo rata di prestito 
Usa la funzione per determinare quale rata mensile ti consente di estinguere un prestito in 5 anni. 

Esercizi 
Gestione scenari: variazioni di costo del personale 
Crea almeno tre scenari in cui il costo del personale varia del 10%, 20%, e 30%, e confronta i margini 
operativi. 
Ricerca obiettivo: target di vendite 
Trova il numero minimo di unità da vendere per ottenere un profitto netto di €15.000. 
Tabella dati: effetto di sconto e quantità 
Crea una tabella con sconti variabili e quantità diverse per visualizzare il totale delle vendite. 
Scenario: analisi trimestrale delle spese 
Usa scenari per confrontare le spese nei diversi trimestri dell’anno e determinare il più vantaggioso. 
Goal Seek: calcolo del tasso di interesse 
Determina il tasso d’interesse necessario per ottenere un capitale finale dato un capitale iniziale e un periodo. 



  



2. Esplorazione dei tipi di Analisi What-If in Microsoft Excel 

a. Tipi di analisi What-If 
Excel offre tre principali tipi di analisi What-If: 
- **Gestione scenari** (Scenario Manager) 
- **Ricerca obiettivo** (Goal Seek) 
- **Tabella dati** (Data Table) 

b. Esecuzione di analisi What-If manuale 
Un'analisi What-If manuale consiste nel modificare direttamente i valori delle celle di input per osservare come 
cambiano i risultati delle formule collegate. Non richiede strumenti specifici, ma è utile per verifiche rapide.  

c. Creazione di tabelle dati 
Le **tabelle dati** (Data Tables) permettono di analizzare rapidamente l'effetto di una o due variabili su una 
formula. Sono strumenti dinamici che automatizzano il processo di analisi. 

d. Creazione di una tabella dati a input singolo 
Permette di analizzare una formula rispetto a un solo valore variabile. Per creare una tabella dati a input 
singolo: 
- Inserire la formula nella cella obiettivo. 
- Inserire una serie di valori verticali o orizzontali. 
- Selezionare l'intervallo, poi: Ribbon → Dati → Analisi di simulazione → Tabella dati. 
- Inserire la cella di input (riga o colonna). 

e. Creazione di una tabella dati a due input 
Questa tabella consente di analizzare l’effetto combinato di due variabili su una formula. Disporre i valori 
orizzontalmente e verticalmente e inserire la formula nell’intersezione. Poi usare lo strumento 'Tabella dati'. 

f. Utilizzo della Gestione scenari 

g. Definizione di scenari 
Gli scenari sono gruppi di valori salvati che Excel può applicare per visualizzare diversi risultati. Per definire 
scenari: 
- Dati → Analisi di simulazione → Gestione scenari → Aggiungi. 
- Specificare nome scenario, celle da variare e valori corrispondenti. 

h. Visualizzazione degli scenari 
Per visualizzare uno scenario definito: 
- Dati → Analisi di simulazione → Gestione scenari → Selezionare uno scenario → Mostra. 

i. Modifica degli scenari 
Gli scenari esistenti possono essere modificati: 
- Dati → Analisi di simulazione → Gestione scenari → Seleziona scenario → Modifica. 

j. Unione di scenari 
È possibile importare scenari da altri fogli: 
- Dati → Analisi di simulazione → Gestione scenari → Unisci. 

k. Generazione di un report di scenario 
Per creare un report riepilogativo: 
- Dati → Analisi di simulazione → Gestione scenari → Riepilogo → Selezionare cella risultato. 
Il report è generato in un nuovo foglio di lavoro. 

Esempi pratici 
Tabella a input singolo: variazione del tasso di interesse 
Analizza il cambiamento del valore futuro in base a diversi tassi d’interesse. 
Tabella a due input: rate e anni per mutuo 
Mostra le rate in base a diverse combinazioni di tasso e durata del mutuo. 
Scenario: budget familiare con 3 livelli di spesa 



Confronta risparmi con scenari 'Minimo', 'Normale', 'Alto' per le spese mensili. 
Scenario: previsioni di fatturato 
Simula vendite ottimistiche, realistiche e pessimistiche e confronta i risultati. 
Goal Seek: utile desiderato 
Determina il prezzo minimo da applicare per ottenere un certo utile netto. 

Esercizi 
Crea una tabella a input singolo 
Simula il valore futuro di un investimento per diversi tassi di rendimento. 
Crea una tabella a doppio input 
Varia prezzo e quantità per analizzare l’impatto sulle entrate lorde. 
Definisci tre scenari di budget 
Crea scenari per tre livelli di spesa differenti e confronta i saldi mensili. 
Modifica e unisci scenari 
Modifica uno scenario esistente e uniscilo con scenari da un altro foglio. 
Genera un report di scenari 
Crea e analizza un report riepilogativo per tre scenari diversi. 

  



3. Analisi dei dati con l'intelligenza artificiale in Microsoft Excel 

a. Utilizzo dei suggerimenti di Excel 
Excel integra strumenti basati su intelligenza artificiale per fornire suggerimenti intelligenti e analisi 
automatiche sui dati. 
 
Per accedere a questi strumenti: 
- Barra multifunzione (Ribbon): scheda 'Home' → gruppo 'Analisi' → 'Analisi dei dati' (Analyze Data). 
- Shortcut da tastiera: ALT + Q e digitare 'Analisi dei dati' per accedere rapidamente. 
 
La funzionalità **Analisi dei dati** (Analyze Data) permette di interrogare i dati in linguaggio naturale, ottenere 
insight automatici, creare tabelle pivot, grafici e identificare tendenze significative. 

b. Interrogazione dei dati analizzati 
Una volta attivata l'Analisi dei dati, è possibile digitare una domanda nel pannello laterale in linguaggio 
naturale, come ad esempio: 
- 'Qual è il totale delle vendite per prodotto?' 
- 'Mostra un grafico a barre per regione.' 
 
Excel analizzerà i dati e restituirà una risposta visiva o tabellare coerente con la richiesta. I suggerimenti sono 
contestuali, in base al contenuto del foglio. 
Funzioni correlate che possono essere utilizzate nell'analisi dei dati: 
**SOMMA.SE (SUMIF)** — Somma i valori in un intervallo che soddisfano una condizione. 
Sintassi: `=SOMMA.SE(intervallo, criterio, [intervallo_somma])` 
**CONTA.SE (COUNTIF)** — Conta il numero di celle che soddisfano un criterio. 
Sintassi: `=CONTA.SE(intervallo, criterio)` 
**CERCA.VERT (VLOOKUP)** — Cerca un valore nella prima colonna di un intervallo. 
Sintassi: `=CERCA.VERT(valore, tabella, indice_colonna, [intervallo])` 
**FILTRO (FILTER)** — Filtra un intervallo in base a criteri. 
Sintassi: `=FILTRO(matrice, include, [se_vuoto])` 

Esempi pratici 
Suggerimenti automatici su un foglio vendite 
Inserisci una tabella con colonne Prodotto, Regione, Vendite. Clic su 'Analisi dei dati' e osserva i grafici e 
riepiloghi generati. 
Domande in linguaggio naturale 
Chiedi 'Trend delle vendite nel tempo' nel pannello 'Analisi dei dati'. Excel restituirà un grafico a linee basato 
sui dati temporali. 
Confronto tra categorie 
Con dati categorizzati (es. tipo di prodotto), chiedi un confronto dei valori per categoria. 
Uso di FILTRO per analisi su subset 
Applica la funzione FILTRO per visualizzare solo i dati delle vendite superiori a 1000€. 
Analisi per parola chiave 
Scrivi 'Totale vendite per regione' per generare una tabella pivot automaticamente. 

Esercizi 
Esplora un set di dati con Analisi dei dati 
Importa un file Excel con dati di vendita e usa lo strumento 'Analisi dei dati' per ottenere almeno 3 insight 
automatici. 
Crea una domanda personalizzata 
Formula una domanda libera nel pannello laterale e verifica il risultato restituito. 
Combina suggerimenti con tabelle pivot 
Utilizza un suggerimento per creare una tabella pivot e personalizzala per mostrare vendite per trimestre. 
Utilizza CERCA.VERT in base all’analisi AI 
Dopo aver individuato un dato tramite AI, usalo in una formula CERCA.VERT per estrarre altri dettagli. 
Applica FILTRO sui dati suggeriti 
Usa la funzione FILTRO per isolare una categoria di dati identificata nei suggerimenti AI. 

  



4. Utilizzo di Power Query e Power Pivot in Microsoft Excel 

a. Power Query 
Power Query è uno strumento di importazione, trasformazione e pulizia dei dati. Consente di connettersi a 
diverse origini dati, applicare trasformazioni e caricare i dati in Excel. 
 
Accesso da: 
- Ribbon → Dati → gruppo 'Ottieni e trasforma' (Get & Transform Data). 
- Shortcut tastiera: ALT + A + P + N per avviare una nuova query. 
- Barra di ricerca: digitare 'Power Query'. 
 
Le principali operazioni includono: 
- Rimuovere colonne/righe 
- Cambiare tipo dati 
- Unire e accodare tabelle 
- Filtrare, ordinare, raggruppare dati 
- Applicare colonne condizionali 
- Eseguire trasformazioni personalizzate in linguaggio M 

Esempi pratici 
Importa dati da file CSV 
Collegati a un file CSV, rimuovi colonne inutili, filtra valori nulli e carica i dati in un nuovo foglio. 
Unione di più fogli Excel 
Importa più fogli da una cartella e uniscili in un’unica tabella con Power Query. 
Colonna condizionale 
Crea una colonna che assegna una categoria ai valori di vendita (es. 'Alto', 'Medio', 'Basso'). 
Raggruppamento per categoria 
Raggruppa per tipo prodotto e calcola la somma delle vendite per ciascuno. 
Filtraggio avanzato con linguaggio M 
Scrivi una query M per mostrare solo i prodotti venduti più di 100 volte. 

Esercizi 
Pulizia di un set di dati 
Importa dati grezzi e applica trasformazioni per prepararli all’analisi. 
Unione tabelle da fonti diverse 
Importa tabelle da file CSV e da database e uniscile in una singola tabella. 
Rimozione duplicati 
Crea una query che rimuova righe duplicate in base a una o più colonne. 
Conversione di tipo e formattazione 
Modifica i tipi di dato e formatta colonne con date e valute corrette. 
Creazione di una colonna personalizzata 
Usa un’espressione M per calcolare uno sconto su ogni prodotto. 

b. Power Pivot 
Power Pivot permette di creare modelli di dati relazionali in Excel, usando tabelle collegate da relazioni e 
formule DAX (Data Analysis Expressions). 
 
Accesso da: 
- Ribbon → Power Pivot → 'Gestisci' (Manage). 
- File → Opzioni → Componenti aggiuntivi → Gestione componenti → Abilita Power Pivot. 
 
Funzionalità chiave: 
- Creazione di tabelle relazionali 
- Calcoli complessi con DAX 
- Modello dati integrato 
- Supporto per grandi volumi di dati 
- Collegamento a Power BI 
Funzioni DAX comuni: 
**CALCOLA (CALCULATE)** — valuta un'espressione in un contesto modificato. 
Sintassi: `CALCOLA(<espressione>, <filtro1>, <filtro2>, ...)` 
**RELATED** — restituisce un valore correlato da un'altra tabella. 
Sintassi: `RELATED(<nome_colonna>)` 
**SUMX** — somma i risultati di un'espressione su una tabella. 
Sintassi: `SUMX(tabella, espressione)` 



**ALL** — rimuove i filtri da una colonna o tabella. 
Sintassi: `ALL(tabella|colonna)` 

Esempi pratici 
Creazione di un modello dati 
Importa tabelle e definisci relazioni tra clienti, ordini e prodotti. 
Calcolo DAX: totale vendite filtrato 
Usa CALCOLA per sommare solo le vendite in una specifica regione. 
Colonne calcolate con RELATED 
Aggiungi colonne che estraggono dati collegati da altre tabelle. 
Misura con SUMX 
Crea una misura che calcola entrate totali moltiplicando quantità per prezzo. 
Filtro globale con ALL 
Confronta vendite di un prodotto con la media globale rimuovendo i filtri. 

Esercizi 
Costruzione modello relazionale 
Crea un modello dati con almeno tre tabelle con relazioni molte-a-uno. 
Colonne calcolate con DAX 
Aggiungi colonne per calcolare IVA e margine su ogni riga vendite. 
Creazione misura personalizzata 
Definisci una misura DAX per sommare vendite filtrate per categoria. 
Tabella pivot da Power Pivot 
Crea una tabella pivot usando dati e misure dal modello di Power Pivot. 
Analisi comparativa con ALL 
Usa ALL per mostrare la percentuale di vendite rispetto al totale globale. 

  



5. Introduzione e utilizzo di Power BI per l'analisi dei dati 

a. Cos'è Power BI 
Power BI è una suite di strumenti di business intelligence sviluppata da Microsoft per analizzare i dati e 
condividere insight. Permette di connettersi a più origini dati, modellare i dati, creare report interattivi e 
dashboard condivisibili sul cloud. 
 
Esistono tre componenti principali: 
- **Power BI Desktop**: applicazione per la creazione di report e modelli dati (scaricabile dal sito Microsoft). 
- **Power BI Service**: servizio cloud per pubblicazione, condivisione e collaborazione. 
- **Power BI Mobile**: app per la consultazione da smartphone e tablet. 

b. Avvio e importazione dati 
Power BI Desktop consente di importare dati da numerose origini: Excel, SQL Server, SharePoint, Web, API, 
ecc. 
 
Percorso: 
- Avvia Power BI Desktop → Home → Ottieni dati (Get Data) → Seleziona origine. 
- Usa la finestra Power Query per trasformare i dati prima di caricarli nel modello. 

c. Modellazione dei dati e relazioni 
Dopo il caricamento, i dati possono essere modellati e relazionati tra loro tramite: 
- Visualizzazione 'Modello' (Model view) per creare relazioni tra tabelle. 
- Definizione di colonne calcolate e misure con DAX (Data Analysis Expressions). 
- Gestione delle tabelle gerarchiche, filtri, KPI, e dati temporali. 

d. Creazione di visualizzazioni 
Trascinando campi nel canvas si possono creare visualizzazioni: 
- Grafici a barre, a linee, ad area 
- Tabelle e matrici 
- Mappe geografiche 
- Grafici a imbuto, indicatori KPI 
- Filtri e segmentazioni (slicer) 
 
È possibile applicare filtri a livello di pagina, report o visualizzazione. 

e. Pubblicazione e condivisione 
Una volta creato il report: 
- File → Pubblica → Seleziona area di lavoro su Power BI Service. 
- Condividi report con colleghi, crea dashboard e programma aggiornamenti automatici. 
- Richiede accesso a un account Microsoft Power BI. 

Esempi pratici 
Importa dati da Excel e crea una dashboard 
Carica un file Excel con vendite, crea una dashboard con grafici a barre, filtri per data e mappe geografiche. 
Crea una misura DAX per margine lordo 
Crea `Margine = SUM(Vendite[Totale]) - SUM(Vendite[Costo])` e usala nei grafici. 
Report comparativo multi-area 
Crea un report con vendite per area geografica e filtri dinamici per categoria. 
Analisi temporale con funzioni DAX 
Usa funzioni come `SAMEPERIODLASTYEAR()` o `DATESYTD()` per confrontare vendite anno su anno. 
Dashboard interattiva per KPI 
Crea indicatori KPI con soglie di colore per visualizzare performance mensile. 

Esercizi 
Importa dati da due origini diverse 
Importa dati da Excel e da una fonte online, uniscili tramite relazioni e visualizza in un report. 
Crea una visualizzazione gerarchica 
Organizza prodotti per categoria e sottocategoria e crea un grafico drill-down. 
Applica filtri multipli 
Crea un report con filtri a livello pagina, visualizzazione e segmentazione interattiva. 
Costruisci una dashboard mobile-friendly 



Usa il layout per mobile per adattare una dashboard a smartphone. 
Crea una misura con `CALCULATE()` 
Crea una misura per calcolare vendite solo in una specifica categoria e visualizzala in un grafico a barre. 
 


